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Chapter 1 : process flow diagram
Process Flow Diagram Symbols. Chemical and Process Engineering Solution from the Industrial Engineering Area of
ConceptDraw Solution Park is a unique tool which contains variety of predesigned process flow diagram symbols for
easy creating various Chemical and Process Flow Diagrams in ConceptDraw DIAGRAM v

It includes all of the connections between the equipment and how one stream is changed to another after it
flows through a piece of equipment. On a separate table, following the process flow diagram, the equipment
must be labeled see "Naming Equipment" and followed by a short description so that the engineer who is
trying to understand the process flow will have a easier time following. The following sections will describe
how to catalog the necessary information for the equipment of the process topology. Process Vessels and
Equipment One of the initial steps to creating a process flow diagram is to add all of the equipment that is in
the plant. Not only is the major equipment, such as distillation columns, reactors, and tanks, necessary to be
shown in a PFD, so is the equipment such as the heat exchangers, the pumps, reactors, mixers, etc. The
following figures will display the most common symbols found in process flow diagrams. Symbols for
Process Technology For process equipment, there are a few standard symbols that should be recognized by
chemical engineers. Typically, these symbols correlate to the ones on the Microsoft Visio Engineering
package that can be used to create process flow diagrams. In the next few sections, the figures will display
various symbols that are used for the process flow diagrams. Figure 1 Towler and Sinnott, displays typical
process equipment - notables ones that should be recognized because they are relevant to this class are the
symbols for the vertical and horizontal vessel, the packed column and the trayed column. For the typical
information that follows the process equipment, refer to "Equipment Information". Various symbols for
reactors, vessels and tanks Towler and Sinnott, Symbols for Heat Exchanger Equipment In addition to the
process equipment symbols, there will be heat exchanger equipment that are essential to process flow
diagrams. Notable symbols that are relevant to this class include the basic heat exchanger symbols, the shell
and tube exchangers, the kettle reboiler, the U-tube exchanger, and heating coils. Other heat exchanger
equipment are listed in Figure 2. Towler and Sinnott, Typical information that follows heat exchanger
equipment are the utility streams that enter and exit the heat exchanger, the pressures, temperature, and the
duties. Various symbols for heat exchanger equipment Towler and Sinnott, Symbols for Fluid Handling
Equipment In a process, some streams may have difficulty moving from one process equipment to another.
Therefore, the placement of fluid handling equipment in between streams can help facilitate this process. In
Figure 3 Towler and Sinnott, , various symbols are displayed for fluid handling equipment. Notable equipment
that we will use for this class include the centrifugal pumps, axial or centrifugal compressor, and the turbine.
In addition to placing this equipment on the process flow diagrams, a separate table should list the name of
this equipment, a description of the type of equipment, and the amount of power supplied to the machinery.
Various symbols for fluid handling equipment Towler and Sinnott, Utility Streams in Process Topology
Utilities are necessary for the plant to keep running. The purpose of the utilities is usually to add or remove
heat to the equipment so that the temperature can be controlled. The type of utility for the duties should also
be specified on a separate table following the process flow diagram. One way to find the type of utility that is
supplied can be done in HYSYS where the process must first be modeled and then sent to the heat exchanger
analyzer. The following bullet points are examples of the many different types of utilities that can service a
plant:
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Chapter 2 : Simple Process Flow Diagram in PowerPoint
Process Flow Diagram Symbols - Valves Gate valve is a device used to control the flow of liquids and gases. Check
valve, also known as one-way valve, is to prevent the line of medium back.

Click the Flowchart category. For each step in the process that you are documenting, drag a flowchart shape
onto your drawing. Connect the flowchart shapes by holding the mouse pointer over the first shape, and then
clicking the small arrow that appears that points to the shape you want to connect to. If the second shape is not
directly across from the first shape, click and hold the small arrow, drag it to the second shape, and drop the
connector in the middle of the second shape. To add text to a shape or connector, select it, and then type.
When you are finished typing, click on a blank area of the page. What the flowchart shapes represent When
you open the Basic Flowchart template, the Basic Flowchart Shapes stencil opens too. Each shape on the
stencil represents a different kind of step in a process. However, there is no standard, universal meaning for
the shapes â€” any shape can carry whatever meaning is agreed on by the people who will create and read the
flowcharts. Most flowcharts tend to use only three or four of the shapes, unless there is a clear business reason
to use more. That said, Visio shapes have names that suggest their most common uses. Here are some of the
most common shapes: This is the most frequently used shape in almost every process. There can be multiple
outcomes, but often there are just two â€” yes and no. This is useful if the diagram is very long and complex.
This is particularly useful for large flowcharts where you would otherwise have to use a long connector, which
can be hard to follow. Each shape on the stencil represents a different step in a process. Visio includes many
other, specialized stencils and shapes that you can use in your flowchart diagram. For more information about
how to find more shapes, see Use the Shapes window to organize and find shapes. To learn about how to find
other shapes, see Use the Shapes window to organize and find shapes Create a flowchart Click the File tab. If
you do not see the File tab, proceed to the next step in the procedure. See the section What the flowchart
shapes represent for information on which shapes to use for each step. Connect the flowchart shapes in either
of the following ways. Connect two shapes together. On the Home tab, in the Tools group, click Connector.
Drag from a connection point on the first shape to a connection point on the second shape. The connector
endpoints turn red when the shapes are connected. Connect one shape to many from a single connection point.
By default, connectors are set to Right-Angle so that if you connect a single point on one shape to three other
shapes it will look like the figure below. To have each connector radiate straight from the central point on the
first shape to points on each of the other shapes you need to set the connectors to Straight Connector as shown
in the following figure. For each shape you want to connect to, drag from the same connection point on the
first shape to a connection point on each of the other shapes. Right-click each connector and click Straight
Connector. To return to normal editing, on the Home tab, in the Tool group, click Pointer Tool. Top of Page
Print a large flowchart The easiest way to print a flowchart that is larger than your printer paper is to print it
onto multiple pieces of paper and then tape the pieces together. Any shapes that hang off the edge of the Visio
drawing page will not print. To print a large flowchart, do the following: Click the File tab. Click Print, and
then click Print Preview. Dotted lines show how the drawing prints onto separate sheets. To print your
flowchart onto multiple pieces of paper, do the following: In the Preview group, click Single Tile to see how
your drawing will print on each sheet. You can switch between pages by clicking Next Tile or Previous Tile.
When you are satisfied with how your drawing looks, in the Print group, click Print. After the drawing is
printed, you can trim the margins, overlap the pages, and tape them together. To print your flowchart onto a
single piece of paper, do the following: Under Print zoom, select Fit to. To the right of Fit to, type 1 in the box
next to sheet s across , and type 1 in the box next to sheet s down. In the Print group, click Print. Of all of the
shapes on the Basic Flowchart Shapes stencil, only a few are commonly used. Those commonly used shapes
are described here. For more information about he less commonly used shapes open the expandable link Less
frequently used flowchart shapes at the end of this section. Process, Decision, Document, or Data. Any text
you type onto the shape, or information you add to its Shape Data, remains with the shape. This is what the
shape looks like on the stencil: This is what you see when you drag the shape onto the drawing page and
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right-click it: You can set the width by dragging the sides of the shape. Use this to add comments about your
flowchart shapes. This represents how a computer hard-drive stores data. When data is stored in sequence, it
must be retrieved in sequence. For example, in order to access record 7 you would have to first go through
records 1 through 6. Early computer systems used a system of punch cards and paper tape to store and retrieve
data and to store and run programs. For information on other ways to connect shapes, see Add connectors
between shapes in Visio. Click the Connector tool For each shape you want to connect to, drag from the same
connection point on the first shape to a connection point on each of the other shapes. Click the Pointer tool on
the Standard toolbar to return to normal editing. Printing large flowcharts The easiest way to print out a
flowchart that is larger than your printer paper is to print it onto multiple pieces of paper and then tape the
pieces together. You can see whether the drawing page is large enough for the flowchart by checking the
preview on the Page Setup dialog box File menu, Page Setup, Print Setup tab. A flowchart that is too large for
the Visio drawing page. A flowchart that fits the Visio drawing page. Make your Visio drawing page fit your
flowchart With your flowchart open, on the File menu click Page Setup. Click the Page Size tab. Under Page
size click Size to fit drawing contents. To see how the flowchart will print, look at the Print Preview, which is
on the File menu. The figure below shows a flowchart that prints on four pieces of letter-sized paper. Print a
large flowchart onto multiple pieces of paper.
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Chapter 3 : Standard Flowchart Symbols and Their Usage
Process flow diagram symbols and elements. The most common PFD symbols in use today come from agencies such
the International Organization for Standardization (ISO - Flow Diagrams for Process Plants, General Rules), the German
Institute for Standardization (DIN) and the American National Standards Institute (ANSI.).

Like other types of diagrams, they help visualize what is going on and thereby help understand a process, and
perhaps also find less-obvious features within the process, like flaws and bottlenecks. There are different types
of flowcharts: The two most common types of boxes in a flowchart are: A flowchart is described as
"cross-functional" when the chart is divided into different vertical or horizontal parts, to describe the control of
different organizational units. A symbol appearing in a particular part is within the control of that
organizational unit. A cross-functional flowchart allows the author to correctly locate the responsibility for
performing an action or making a decision, and to show the responsibility of each organizational unit for
different parts of a single process. Flowcharts depict certain aspects of processes and are usually
complemented by other types of diagram. For instance, Kaoru Ishikawa defined the flowchart as one of the
seven basic tools of quality control, next to the histogram , Pareto chart , check sheet , control chart ,
cause-and-effect diagram , and the scatter diagram. Similarly, in UML , a standard concept-modeling notation
used in software development, the activity diagram , which is a type of flowchart, is just one of many different
diagram types. Nassi-Shneiderman diagrams and Drakon-charts are an alternative notation for process flow.
Common alternative names include: The terms "flowchart" and "flow chart" are used interchangeably. The
underlying graph structure of a flowchart is a flow graph, which abstracts away node types, their contents and
other ancillary information. History[ edit ] The first structured method for documenting process flow, the "
flow process chart ", was introduced by Frank and Lillian Gilbreth in the presentation "Process Charts: In the
early s, an industrial engineer, Allan H. Mogensen began to train business people in the use of some of the
tools of industrial engineering at his Work Simplification Conferences in Lake Placid , New York. Graham ,
another graduate, Director of Formcraft Engineering at Standard Register Industrial , applied the flow process
chart to information processing with his development of the multi-flow process chart, to present multiple
documents and their relationships. Operation and Flow Process Charts. Often pseudo-code is used, which uses
the common idioms of such languages without strictly adhering to the details of a particular one. Nowadays
flowcharts are still used for describing computer algorithms. Types[ edit ] Sterneckert suggested that
flowcharts can be modeled from the perspective of different user groups such as managers, system analysts
and clerks , and that there are four general types: For example, Andrew Veronis named three basic types of
flowcharts: Fryman identified more differences:
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Chapter 4 : Process Flow Chart Tutorial
Many people think that BPMN notation hides secrets and mysteries. In fact, it's the most widely used and accepted
notation in the world, precisely for its ease of use and the intuitive process flow diagram symbols that it employs.

Predefined process indicates a set of steps that combine to create a sub-process that is defined elsewhere, often
on another page of the same drawing. Decision indicates a point where the outcome of a decision dictates the
next step. There can be multiple outcomes, but often there are just two - yes and no. Start points indicates the
starting of a process. Terminal points indicates the ending points of a process. Data shape indicates that
information is coming into the process from outside, or leaving the process. Delay shape represents a waiting
period where no activity is done. In Process Mapping, delays are often important as they may result in adding
to the cost of the product or simply delaying its production. Database shape Use this shape for a step that
results in information being stored. Step represents a single step within a process, and usually contains the
name of a specific action. Page symbols refer to individual web pages, which may or may not contain multiple
elements. File symbols represent those data elements that exist independently of navigational properties
outside of that page, e. Decision point indicates a sequence in the process at which the end user chooses an
option, i. Arrows and connecting lines diagram the logical progression through the course, subject to the
choices made at decision or action points within the process. Conditional selector is similar to the conditional
branch except that the user has the option to choose from a number of paths that will fulfill the requested
conditions, e. Annotations provide helpful comments or explanations, e. Flow references and flow areas are
symbols for reusable sequences, such as logging in with a specific user id and password to enter the course or
to initiate an on-line quiz. The flow reference symbol acts as a placeholder for the flow area sequence in the
chart in every situation in which it is repeated. Flow area is used as a flow area. Exit point concludes the
subroutines, such as when the proper user id and password are verified, and documents where the user
re-enters the master flowchart. Entry point documents the place within the master flowchart where the process
deviates into a subroutine. Reference is used as a connecting point when the flowchart necessitates using more
than one page, or refers to a complicated subroutine that would be impossible to contain on the main flowchart
page. On-page reference indicates that the next or previous step is somewhere else on the flowchart. It is
particularly useful for large flowcharts. Off-page reference use a set of hyperlinks between two pages of a
flowchart or between a sub-process shape and a separate flowchart page that shows the steps in that
sub-process. Flowchart Shapes The designers can click this multi-shape to set to any of the following shapes:
Data, Document, Decision, or Process. Any text you type onto the shape, or information you add to its Shape
Data, remains with the shape. Document represents a step that results in a document. Workflow Shapes
Workflow relationships are where work is done by different departments in a fixed sequence. This means that
one department needs to finish its job before work can continue in another department. The development and
maintenance of these workflow relationships is very important for managers because they depend on the
preceding areas for his or her own work, and responsible for managers and workers at different stages further
down the chain. Audit Flowchart Shapes The following shapes are similar to the basic flowchart symbols but
are specially used in the audit flowchart.
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Chapter 5 : Process flow diagram - processdesign
Process symbols are also commonly called flowchart symbols, flowchart shapes or flow diagram symbols. These
symbols come from the Unified Modeling Language or UML, which is an international standard for drawing process
maps.

Follow our step by step instructions to create this useful diagram in PowerPoint. You can use the diagram
toâ€¦ Portray various steps in a linear process Introduce a color code to the various steps of the process Serve
as an orientation slide for your presentation The diagram is quite easy to create. In this article, we will show
you the steps. Draw the stages of the process Write the title of the slide. This will help you plan the space for
your diagram. Once you finish entering the title, go to Auto shapes menu and pick the Pentagon tool to draw a
Pentagon. Use the Chevron tool to place a chevron next to the pentagon. Make as many copies of the chevron
as the number of steps in the process you want to portray. The result will be as follows: You can apply quick
style of your choice to color code the different steps of the process diagram: Make sure that the height and
width of the pentagon and chevrons are identical. Create the text boxes The next step is to draw the text boxes
that serve to explain the titles. Use the rectangle tool to draw the boxes as shown below: Remove the outline
for the boxes. Keep just two stops for the gradient. Continue the process for the remaining boxes. You will get
the following result: The last step is to enter relevant text in the boxes: Our Process Flow diagram in
PowerPoint is ready. You can choose to keep the color scheme fairly consistent across the steps and use a
contrasting color to draw attention to a certain step in the process as shown below: Creative process diagram
ideas Smarter option for business presenters: The difference between an ordinary graphic and professional
business graphic is the attention given to finer details. It takes a lot of time and effort to create that perfect
looking business graphic which makes your audience sit up and listen to your message. The two CEO packs
have more than premium charts, graphs, graphics and diagrams to help you visualize every business idea
imaginable. Just choose the template that matches your thought and replace sample text with your own text.
Creating professional business slides has never been easier. Here are some process diagrams from PowerPoint
CEO Pack 2 Here is another linear flow diagram from CEO Pack 2 Why waste time creating your graphics
and diagrams from scratch when you can invest the time to hone your content? Please browse through our
diagrams collection now and see how the CEO packs can change the way you create your business
presentations forever. If you found this tutorial useful, do look around our site.
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Chapter 6 : What is a Process Flowchart? Process Flow Diagrams | ASQ
Process Diagrams are fundamental requirements for project design and engineering. Last week, we highlighted the
three types of process diagrams: Block Flow Diagram (BFD), Process Flow Diagram (PFD), and Process and
Instrumentation Diagram (P&ID).

You will only need to drag ready objects from the libraries into your document, arrange and connect them
according to your flowchart idea. An experienced user spent 5 minutes creating this flowchart, thanks to
colorful set of advanced flowchart symbols. Use the process flow chart symbols from the Flowcharts Solution
libraries to quick and easy design various Process Flow Diagrams and Charts. Flow Chart Solution All source
documents are vector graphic documents. Pyramid Diagram Pyramid diagrams help you visualize information
as a triangle divided into horizontal slices. Labelled slices represent a hierarchy. Pyramids are used in
marketing presentations to show and analyze hierarchy levels. The data component include different scattered
signs or symbols which are merely useless until these random objective facts are somehow processed. Data is
a resource which has to be manipulated or rearranged to get useful. Information can be extracted from a pile of
data, it also can be mined from different data storages. The Accounts Payable Process Flow Chart is very
popular and widely used type of accounting flowcharts. Now their designing is simple thanks to the
Accounting Flowcharts Solution that provides the Accounting Flowcharts library of predesigned
commonly-used shapes and a set of templates and samples. Projects have to comply with the specified scope,
projects should be finished in time and projects need to consume the budget. Each of the constraints represents
one side of the triangle, and any change in budget or timing or scope affects the entire diagram. The chart
displays items in concentric circles, where the items in each ring depend on the items in the smaller rings. The
Onion Diagram is able to show layers of a complete system in a few circles. But how to create Onion
Diagram? It is useful to diagram business processes to ensure that they are as foolproof, logical and sequential
as possible. This business process diagram describes a typical booking process flow by the example of a cab
booking process. It can be used as a roadmap for any booking system implementation. Diagramming a
business process allows you to look at the entire project and take into account all types of possible scenarios.
Business process diagram helps you investigate and clarify the process thoroughly so that you can find out
how it can be improved. Business process diagram supports team communications by ensuring that each
process element is clear and everyone in the team is on the same page. In return, you will increase your
productivity and get more done in a less time. This tool is unique to fulfill all your needs in short period of
time. Over the recent years object-oriented methodology has become more and more widespread. Thanks to
this methodology developers manage to deal with growing complexity of applications. However, the
complexity of the designed systems imposes extended requirements as to design of graphic documentation.
ConceptDraw possesses powerful tools for designing of technical documentation for object-oriented projects.
The libraries included in the package allow to easily draw class hierarchies, object hierarchies and diagrams of
data flows with the use of the most popular notations, including UML and Booch notations. When drawing
flowcharts, keep in mind that there are four common types of flowcharts, like document flowcharts and data
flowcharts that show control over a data or document flow over a system. To show controls on a physical
level, use system flowcharts. In addition, to show controls in a program, you can draw a program flowchart.
This flowchart diagram represents the piece of an article editing process, that involves the author and editor. It
was created using the Basic Flowchart notation that consists from the basic flowchart symbols. The start and
the end of the process are indicated with "Terminator" symbols. The "Process" symbols show the action steps
consisting from making edits and searching for a compromise, when the author does not agree with the
suggestions of the editor. The "Process" symbol is the general symbol in process flowcharts. The "Decision"
symbol indicates a branching in the process flow. This basic flowchart can be used as a repeating unit in the
workflow diagram describing the working process of some editorial office. Physics solution provides all tools
that you can need for physics diagrams designing. It includes 3 libraries with predesigned vector physics
symbols: There is a short and an extended list of basic flowchart symbols and their meaning. Basic flowchart
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symbols include terminator objects, rectangles for describing steps of a process, diamonds representing
appearing conditions and questions and parallelograms to show incoming data. This diagram gives a general
review of the standard symbols that are used when creating flowcharts and process flow diagrams. The
practice of using a set of standard flowchart symbols was admitted in order to make flowcharts and other
process flow diagrams created by any person properly understandable by other people. The flowchart symbols
depict different kinds of actions and phases in a process. The sequence of the actions, and the relationships
between them are shown by special lines and arrows. There are a large number of flowchart symbols. Which
of them can be used in the particular diagram depends on its type. For instance, some symbols used in data
flow diagrams usually are not used in the process flowcharts. Business process system use exactly these
flowchart symbols.
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Chapter 7 : Process flow diagram - Wikipedia
Five Basic Flowchart Symbols. Flowcharts are the ideal diagrams for visually representing business processes. For
example, if you need to show the flow of a custom-order process through various departments within your organization,
you can use a flowchart.

Therefore, it is important that all professionals involved with BPM fully master the meaning of the flowchart
process mapping symbols. We will detail some of the process mapping symbols most used and known, to
facilitate their understanding, without going into more complex and advanced variations. Using these symbols,
you can map processes with agility and clarity. And if necessary, a second time using tools and more specific
software that can have more resources and meanings. Meanings of flow chart process mapping symbols The
first symbol to be displayed is the arrow, a connection symbol used to indicate a link between two other
symbols and the direction of flow. Next, we will show various designs of shapes with their meaning of these
symbols in the process flowchart. Termination Process flow diagram: Process Process flow diagram: It
indicates a particular process and its functions and activities. Decision Process flow diagram: It shows that a
decision will have to be taken and the process flow will follow a certain direction due to this decision. Delay
Process flow diagram: Is that some time will pass before the process flow continues. Data Process flow
diagram: Document Process flow diagram: It is a type of data or information that can be read by people, such
as a printed report, for example. Various documents Process flow diagram: It indicates that there are several
documents. Subroutine or default process Process flow diagram: A process that is already pre-defined.
Preparation Process flow diagram: It shows that something must be done, adjusted or modified in the process
before proceeding. Display Process flow diagram: It indicates that any information or data is displayed for
reading on a screen or other display. Manual entry Process flow diagram: It shows that a procedure will be
performed manually by a person. Loop manual Process flow diagram: It indicates that a command sequence
will occur continuously in repetition until stopped manually by a person. Loop Limit Process flow diagram: It
shows the beginning of a loop process. Stored Data Process flow diagram: It shows that there is stored data.
Connector Process flow diagram: It indicates that there is an inspection at this point. Connector to another
page Process flow diagram: It shows that there are a cross-reference and link to this process from another
process designed on another page. OR Process flow diagram: Adder Process flow diagram: Group Process
flow diagram: Indicates a step in which the data is organized in a standard way. Rate Process flow diagram: It
shows that at this point there will be a list generated that organizes items in a particular order. Merge Process
flow diagram: Indicates a step that will combine several sets into one. Database Process flow diagram: A list
of information with a standardized structure that allows searching and sorting. Internal Storage Process flow
diagram: These were the 23 main meanings of flowchart process mapping symbols. Using these symbols, you
will be able to map processes and interpret flowcharts. If you are looking for a more modern notation be sure
to watch the video below about BPMN: Read more related articles:
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Chapter 8 : Standard Process Flow Diagram Symbols and Their Usage
The following is a basic overview, with descriptions and meanings, of the most common flowchart symbols - also
commonly called flowchart shapes, flow diagram symbols or process mapping symbols, depending upon what type of
diagram you're creating.

Vessels Library Use of these predesigned process flow diagram symbols is a fastest way of professional
process and chemical engineering drawing. They will help you draw any chemical or process flow diagram in
mere minutes. Simply drag the needed objects from the libraries to the document and arrange them. They will
always have a success and will help you easily explain your thoughts to the colleagues. An experienced user
spent 20 minutes creating this sample. All source documents are vector graphic documents. Building Drawing
Design Element: Machines and Equipment Use ConceptDraw to develop the plant layouts for production,
storage, distribution, transport, shipping, and receiving of manufactured goods. Machines and Equipment
Related Solution: Process Flow Diagrams are widely used by engineers in chemical and process engineering,
they allows to indicate the general flow of plant process streams and equipment, helps to design the petroleum
refineries, petrochemical and chemical plants, natural gas processing plants, and many other industrial
facilities. When drawing flowcharts, keep in mind that there are four common types of flowcharts, like
document flowcharts and data flowcharts that show control over a data or document flow over a system. To
show controls on a physical level, use system flowcharts. In addition, to show controls in a program, you can
draw a program flowchart. This flowchart diagram represents the piece of an article editing process, that
involves the author and editor. It was created using the Basic Flowchart notation that consists from the basic
flowchart symbols. The start and the end of the process are indicated with "Terminator" symbols. The
"Process" symbols show the action steps consisting from making edits and searching for a compromise, when
the author does not agree with the suggestions of the editor. The "Process" symbol is the general symbol in
process flowcharts. The "Decision" symbol indicates a branching in the process flow. This basic flowchart can
be used as a repeating unit in the workflow diagram describing the working process of some editorial office.
ConceptDraw DIAGRAM v12 is business process mapping software with impressive range of productivity
features for business process management and classic project management. This business process management
software is helpful for many purposes from different payment processes, or manufacturing processes to
chemical processes. Business process mapping flowcharts helps clarify the actual workflow of different people
engaged in the same process. This flowchart diagram shows a process flow of project management. The
diagram that is presented here depicts the project life cycle that is basic for the most of project management
methods. Breaking a project into phases allows to track it in the proper manner. Through separation on phases,
the total workflow of a project is divided into some foreseeable components, thus making it easier to follow
the project status. A project life cycle commonly includes: Distinguished method to show parallel and
interdependent processes, as well as project life cycle relationships. A flowchart diagram is often used as
visual guide to project. For instance, it used by marketing project management software for visualizing stages
of marketing activities or as project management workflow tools. Computer and Network Examples Computer
networks nowadays are spread all across the world. The large number of parameters, such as geographic scale
or communication protocols, can divide networks. One of the most common types of networks is called local
area network LAN. It convenient to represent network examples by means of diagrams. This local area
network LAN diagram provides an easy way to see the way the devices in a local network are interacted. The
diagram uses a library containing specific symbols to represent network equipment , media and the end-user
devices such as computers PC, mac, laptop , network printer, hubs, server and finally a modem. There are two
types of network topologies: The current diagram represents precisely a physical type of LAN topology
because it refers to the physical layout of a local network equipment. Local area network LAN. Computer and
Network Examples Related Solution: There are a lot of standard symbols depicting valves, pumps, motors,
etc. The solution is composed from the 8 libraries, containing about elements related to mechanical
engineering visualization. All drawings can be freely resized without loss of quality due to the vector graphics
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components of its facilities. The next stage of developing is a technical drawing, which requires using
appropriate software. However, revisions and discussions about requirements are possible at any stage of
development. This technical drawing demonstrates a schematic flow diagram of pulp reclaiming. This diagram
of magnetite pulp reclaiming is created using ConceptDraw Chemical and Process engineering solution, The
solution delivers more than vector graphic icons and connectors. A library of vector objects composed from
symbols of Analog and Digital Logic elements of electric circuit includes 40 symbolic images of logic gates,
bistable switches of bi-stable electric current, circuit controllers, amplifiers, regulators, generators, etc. All of
them can be applied in electronic circuit schemes for showing both analog and digital elements of the circuit.
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Chapter 9 : Create a basic flowchart - Visio
The primary technique in Business Process Modeling (BPM) is the creation of flow charts and proper use of process
flow chart symbols. But first, let me back up to the official definition of business process modeling and a few facts to
level set the conversation. Business process modeling is the.

A Process Flow Diagram is a paper-based tool which represents a series of activities as a diagram. It can be
used by improvement teams with little formal training. Why is it used? To identify weaknesses in existing
process arrangements and to highlight improvement points. When is it used? In early diagnostic work. Finding
out how the process currently works is an important part of the data collection phase, so it is usual to construct
a Process Flow Diagram as an initial activity. More detailed process flow analysis can be used later on, and the
technique forms a key element in business process re-engineering. How is it used? Every business activity can
be viewed as a process. In simple terms, a process is the transformation of inputs into outputs. When looking
to make improvements it is useful to be able to view activities as a formal process. The aim of a Process Flow
Diagram is to lay out clearly the step-by-step flow of a process by tracking the flow of material, information or
a service through all its steps. In doing this the diagram: Helps a wide and sometimes unfamiliar audience to
picture the steps of a process and clarifies misconceptions about how the process actually operates. Helps to
determine and position actions that will prevent problems, as well as identifying major sub-processes which
may require their own process definition. Provides a reference for the handling of corrective action or process
improvement. Once the steps in the process are clear, simple analysis can reveal opportunities for
improvement. Like any versatile tool, there are many variations of Process Flow Diagram. Each activity is
placed in one of the following five activity categories. Identify and confirm the scope of the process that is
under review, paying particular attention to the start and finish points. Determine and list the steps required to
carry out the process. Each action step should be named as a phrase containing a verb and a noun. Sequence
the steps correctly and mark the activity category with a dot. Join the dots and calculate the totals. It is
important that the diagram reflects the true situation as closely as possible, and that the group constructing it
reaches consensus.
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